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Program Origin
How Old are Ya'  is the result of a game that I used to play with my children.    Over dinner, I would 
ask them to calculate their ages in Hours, Minutes and Seconds.    This would always create quite a stir 
with much running around searching for calculators and other paraphernalia.    When they were almost 
done, I would throw in such things as Leap Years and Birth Times.    Who knows if they ever got it right, 
but they had fun trying.

When I first purchased Visual Basic, I wanted to write a simple program and this game came to mind.    I 
first wrote the program in 1991.    It was somewhat flawed when I first submitted it as Shareware.    Now 
that I have Version 3.0 of Visual Basic and more experience, the program has been much improved.

I have recently acquired another program, Doc-To-Help, to write Help Files with the aid of Microsoft Word. 
Thus I have added this file to the program.

I hope that you enjoy using this program.    If you have any questions or comments, please feel free to 
contact me at any time.

See: Support



Program Requirements
This program requires Visual Basic's Runtime Library VBRUN300.DLL. Because of its size and common 
use, it is not included in the Shareware version of this program.    This file can be obtained through 
numerous libraries in Compuserve, America On Line and other on line services.    All other files required to
run this program are included.    The *.VBX and *.DLL files should be placed into your Windows\System 
Subdirectory or into another Subdirectory that is in your DOS Path.



Uninstalling How Old are Ya'
In order to uninstall the program, you must know where the program resides.    This is the program's 
Working Directory.    The files to remove here, are HOWOLD.EXE and HOWOLD.HLP.    If your program 
is not registered, REGISTER.WRI, INSTALL.WRI and FILE_ID.DIZ are also in this directory.    If you have
created a Name Data File, then HOWOLD.DAT should also be removed from this directory.    The 
program creates another file in your Windows Subdirectory.    This is the program's initialization file, 
HOWOLD.INI.    The compressed file, HOWOLD.ZIP, that you downloaded is probably in your program's 
working directory.    All of these files should be deleted to uninstall the program.

The other files created when you installed the program are MSAFINX.DLL, MSMASKED.VBX and 
VBRUN300.DLL are probably in your Windows\System Subdirectory.    CAUTION should be used in 
removing these files, as they may be being used by other programs in your system.

No changes are made by this program to your WIN.INI or to any other system files.

Click here to Print this Topic...



Shareware
This program is presented as Shareware.    If you use and enjoy this program, please REGISTER.

See: Registration

Click here for the Registration Form...
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Purpose
The purpose of this program is to calculate your Age in Years, Months, Weeks, Days, Hours, Minutes, 
Seconds and the Day of the Week of your Birth.    This is all based upon a Birth Date and a Birth Time that
You enter and your Computer's System Time.

See: Calculations



Entering & Clearing Data
You can enter the Birth Date and Time in two ways:

1. Enter the Birth Date and Birth Time directly into the program when it loads.

2. Enter the Birth Date and Birth Time by selecting a Name from the Name List Box.

See Selecting Names

Once you have the Birth Date and Time entered, press the Enter Key or press the Ya' Button with the 
Mouse.    The How Old are Ya' calculations will be completed, and the program screen will change to 
show the results.

When you are done viewing the results, either press the Enter Key or click the Clear Button to clear the 
program screen and to bring it back to it's original state.

At any time, while you are entering data, you can press the ESC Key or click the Clear Button to clear the 
Data entry fields.



Calculations
The How Old are Ya' calculations subtract the Birth Date and Time from your Computer's System Time to 
arrive at the results.    The more accurate your Computer's System Time, the more accurate the results 
will be.



Results
When you enter a valid Date and Time, the program shows the results of it's calculations.    Ordinarily you
will see your age in seconds increment along with the system time.    The rest of the results will also 
increment as they change.

See: Limitations

While you are viewing the Results, notice that the Names, Register and Help Menus are disabled.    You 
can still turn the Timer On and Off either through the Timer Menu or by clicking the Current Time Line.

As an example, see: 24 Hour Screen Example



Data Base
The program allows you build a Data Base of Individuals with their Birth Dates and Times to make Data 
Entry easier.    If you never enter a name into the Data Base, the Names List Box will not appear in the 
program.    This Data Base stores the Individual's First Name, Last Name, Birth Date and Birth Time.    
Names can be Added to or Deleted from the list.

See: Adding Names to the Data File

See: Deleting Names From the Data File



Limitations
This program is limited to Birth Years in the 1900's only.    This allows entry of only two digits for the Year.

If you are over 65, the Seconds calculation will not change with the current time in one second 
increments.    The seconds will change only in 60 second increments as the Minutes change.

If you enter a Birth Date and Time that exceeds the Computer's System Time, all Zero's will appear in the
results until the System Time reaches the Birth Time.
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File Menu
The Print Function is dimmed until you are showing a Birth Date and Time.    You can print your selection 
by selecting Print from this menu or by pressing <CTRL P>.

This menu also contains the Exit Function.    Use this function or the other standard Windows Methods, 
including <ALT><F4> to exit the program.



Timer Menu
This Menu contains two choices, On or Off.    The default setting is On.    When the Timer is set to On, you
will see the Seconds changing in the Current Time.    When the Timer is set to Off, the Current Time will 
freeze.

See: Timer



Names Menu
This Menu offers two choices, Add Names and Delete Names.    These choices control the list of names 
that are stored by the program to allow you to retrieve Individual's Data for use in the program.

The Add Names choice brings up a Dialog Box that enables you to add names to your Data File.

See: Adding Names to the Data File

The Delete Names choice brings up a Dialog Box that enables you to remove names from your Data File.

See: Deleting Names From the Data File



Register Menu
This Menu offers three choices, How to Register, Print Registration Form and Register.

The How to Register choice brings up a Dialog Box giving you the information needed to Register this 
Program.

The Registration Form choice loads a Windows Write file that you print out and complete to start the 
Program's registration process.

The Register choice brings up a Dialog Box that allows you input the Program Registration Data.    When 
this is properly completed, all references to Registration are removed from the program.

See: Starting the Registration Process



Help Menu
This Menu is a standard Windows Help Menu.    The first choice, Contents, takes you to the Contents 
Section of the Help File.    The Uninstall choice takes you to the Section in the Help File that tells you how
to uninstall the program in the unfortunate event that you don't like it.



Data Entry
All Data Entry is checked for Content and Length.    This applies to Dates, Times and Text.    If you enter 
invalid data, an Error Message will be generated telling you the mistake that you made.

Related Topics:
Entering Dates
Entering Times
Entering Text
Selecting Names



Entering Dates
All Dates must be entered in MM/DD/YY format.    All Month and Day entries must be valid.    Months, 
Days and Years less than 10 must be entered with leading Zeros.    Thus March 9, 1907, must be entered 
as 03/09/07.    Year entries are limited to the 1900's.    Anyone born before 1900 is out of luck as far as this
program is concerned.

See: Limitations

It is unnecessary to punctuate Date Entries.    The / ' s are entered automatically for you.    For example, to
enter a Date of 08/12/74, all you need type is 081274.

Date Fields will only accept numeric characters.

 If you enter invalid data, an Error Message will be generated telling you the mistake that you made.



Entering Times
All Times must be entered in HH:MM format.    All Hour and Minute entries must be valid.    Hours and 
Minutes less than 10 must be entered with leading Zeros.    Thus, 8:09 must be entered as 08:09.

All times are entered in Military (24 Hour) Time Format.    This affects all Times between 12:00 Noon and 
12:00 Midnight.    1:00 P.M. is entered as 13:00.    11:59 PM is entered as 23:59 and 12:00 Midnight is 
entered as 00:00.

It is unnecessary to punctuate Time Entries.    The : ' s are entered automatically for you.    For example, 
to enter a Time of 10:30, all you need type is 1030.

Time Fields will only accept numeric characters.

If you do not make an entry into a Time Field, a default time of 12:00 Noon will be entered automatically.

If you enter invalid data, an Error Message will be generated telling you the mistake that you made.



Entering Text
All text that you enter into this program is checked for Length.    If you exceed the Length of a Text Field, 
an Error Message will be generated.

All Text is automatically converted to Upper Case.

The Text Limits for this program are:

· First Name 15 Characters

· Last Name 15 Characters



Selecting Names
If you have Names stored in the program's data file, they will appear in a List Box when you load the 
program.    The List Box will not appear if there are no names stored in the Data File.    To select a name, 
point to it with your Mouse and click.    The Birth Date and Birth Time Data for that individual will 
automatically be filled in.    If you Double Click on the Name, the Name will be selected and the How Old 
are Ya' calculations will be done all in one step.

If you do not have a Mouse, use the Tab Key to set focus on the List Box.    Then select a name using the
up or down arrow keys and press the Enter Key to do the How Old are Ya' calculations.

If you are in the Delete Names Dialog Box, selecting a name will enable the Delete Button.



Timer
The Timer can be toggled (switched) On or Off in two ways.

1. Select On or Off in the Timer Menu

2. Click on the Current Time Line.    Notice that your Mouse Pointer changes to an up-arrow ( Ý ) 
when you have the Pointer on this line.



Adding Names to the Data File
To add names to the data file, select Add Names from the Names Menu.    The Add Names Dialog Box 
will come up.    Four Entries are required to add a name to the Data File.

1. First Name
2. Last Name
3. Birth Date
4. Birth Time

The First Name and Last Name entries are text entries.    They are limited to 15 characters each.    If you 
exceed this limit an Error Message will be generated.

The Birth Date must be entered in MM/DD/YY Format.

See: Entering Dates

The Birth Time must be entered in HH:MM Format.    Entering a Birth Time is optional.    If no Birth Time is 
entered, a time of 12:00 Noon is entered.

See: Entering Times

When you have completed the entries, press the Enter Key or Click on Save with your Mouse.    You will 
then be asked to confirm the entry.    Select Yes or No in response to the confirmation.    You will then be 
taken back to the Add Names Dialog Box.

At any time during Data Entry, you can press the ESC Key or click the Clear Button with your Mouse to 
clear the fields and start over.



Deleting Names From the Data File
To delete names from the data file, select Delete Names from the Names Menu.    The Delete Names 
Dialog Box will come up.    Select a Name from the List Box and either press the Enter Key or click the 
Delete Button with your Mouse.

See: Selecting Names

You will then be asked to confirm your selection.    Select Yes or No in response to the confirmation.    You 
will then be taken back to the Delete Names Dialog Box.



Printing
You can print your results by selecting Print from the File Menu or by pressing <CTRL P> when the 
results are shown.

The Print selection in the File Menu is not enabled until you are showing results.



Registration Benefits and Cost
All Registered users will receive the following:

1. Free upgrades for this Program as they occur.

2. All references to Registration will be removed from the Main Program.

3. Notification of other programs available from this author.

If you include your Compuserve or Internet Number along with your Registration, I will notify you through 
Return Mail in that Service of your Registration Information.

On Line Registration Costs: $    7.50

Registration with Setup Disk Costs: $12.50

See: Starting the Registration Process



Starting the Registration Process
Register By Mail
Register Through Compuserve



Register By Mail
To Register by mail and receive a Setup Disk send $12.50 to:

Tom Hill
Convenient Software

P.O. BOX # 246
Geneseo, New York 14454

You may find it easiest to Print out and Complete the Registration Form.    To do this, select Registration 
Form... from the Register Menu of the program or click the line below.

Be sure to include your Name and Address with your registration.
Click here for the Registration Form...



Register Through Compuserve
In Compuserve GO SWREG.    The registration Number is 1529
Follow the instructions from Compuserve to Register.

Cost is $7.50.



Ending the Registration Process
When you receive your Registration Information, select Register from the Register Menu.    The 
Registration dialog box will appear.    Enter your Name and Registration Serial Number exactly as you 
receive them.    If you make a mistake entering the information, an Error Message will appear.

Upon successful completion of the form, exit back to the Main Program and all references to Registration 
will have been removed from the Main Program.    Open the About Box from the Help Menu and you will 
see that your Registration Information has been entered.

Your registration information is stored in the HOWOLD.INI file in your Windows Subdirectory.    Be sure to 
save your Registration Information for future use.    If you do lose this information, you can contact me at 
any time.

See: Support



Support
For Support Contact:

TOM HILL
CONVENIENT SOFTWARE

P.O. BOX 246
GENESEO, NEW YORK 14455

PHONE:    716-243-5832
COMPUSERVE:    70702,427

AMERICA ON LINE:    THOMASH339
INTERNET:    70702.427@COMPUSERVE.COM



Disclaimer
No Warranties, either expressed or implied, are given with this program.    This program is presented as a 
GAME and as such, is NOT intended for SERIOUS USE.



24 Hour Screen Example

This example was created by setting the Birth Date to the day before the Current Date and by setting the 
Birth Time to one minute after the Current Time.    When the Current Time reached the Set Time, I clicked 
on the Current Time Line to turn the Timer off and took a snapshot of the screen by pressing <ALT><Print 
Screen>.



Visual Basic is a registered trademark of Microsoft Corporation.



Doc-To-Help is a registered trademark of Wextech Systems, Inc.




